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System Requirements

CPU : Pentium processor or higher.

Memory : 16MB RAM

Hard Disk : 255MB free hard disk space

CD Drive : A CD drive to load Shri Muhurta in the computer

Monitor : Color monitor with 16 bit color and 800 x 600
resolution

Operating System : Windows 95 or Windows 98

Installation procedure

1. Insert the CD in the drive.

2. It will automatically launch the installation program. If it does not, then
execute MuhurtaSetup.exe either through Run in the Start Menu, or
through Windows Explorer or through My Computer.

3. The installation program will be launched, and it will guide you through
the rest of the setup process. It is easiest to keep the default settings of the
installer.

4. If the software is supplied with a software protection key, connect this
key on the printer port at the back of your computer. If you also have a
printer connected, put it between the printer cable and the printer port,
i.e. printer port < key < printer cable.

Chapter 1: Installation
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5. To activate the key, click on icon �Install Hasp� or execute �HDD16.exe� (or
HDD32.exe) from the CD.

6. Restart your computer to enable the new settings.

7. You can start the software by clicking on Shri Muhurta in the following
way : Start->Programs->Jyotish->Shri Muhurta.

8. A window will appear asking you for your username and password.. Please
contact your distributor for these details if the same is not already avail-
able on your CD Box label. Enter the same and click on OK.
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What is Muhurta

Talking in a strict scientific sense, all things in this Universe are finite, all
except two.  Time and  Space.  Time had no beginning and is going to have no
end. That means that there was no point, no instance at which we can say
that time came into existence, or time started. And in the same way, we can
not say that at such and such instance, time is going to exist no more, or its
going to stop running. Similarly, space has no dimensions. It doesn�t start
anywhere and doesn�t end anywhere. The modern man has always tried to
understand both the elements and travels at will in them but has found al-
most no success so far.

There are innumerable influences cast by both these elements on man. They
effect the human life significantly. And the ancient sages understood this only
too well. And through the powers of the mind and soul, through concentra-
tion and meditation, through various super-conscious and sub-conscious ener-
gies and powers, through super-human intellect and divine bliss, they under-
stood all these factors beyond the reach of any modern day technology. They
saw and understood, how time and space influence us, how stars and planets
in the sky effect us and how significantly they can change a man�s course of
life .

And they understood the most important thing too. And that is how man can
change the course of his own future and lead  an  amazingly superb  and  a
successful life by working in alliance with the stellar bodies. And Muhurta is
the most important concept they discovered.

Chapter 2 : Introduction
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Muhurta is the selection of the best date and time for performing any work. It
helps in concentrating the energy of the planets and other astrological factors
in an auspicious way so as to nullify the evil influences and make the result of
the work performed most fruitful. It helps in counteracting the obstructions
provided by the birth chart of a person and to neutralize or overcome the loss
mentioned therein.

It synchronizes the energy of the person, the stars and the event itself so as to
make it utmost advantageous to the person performing the work.

So, whenever you are going in for some important consideration of your life,
which either takes a significant amount of your time and energy or is going to
make its impact on your life for quite sometime, then you should perform that
action in accordance to the Muhurta, so that it can be of utmost advantage to
you and you can lead a much better, happier, satisfactory and gratified life.

In astrology, the starting time of an event is taken for the calculation of the
horoscope and making the interpretations. So, the starting or the beginning
time is the most important factor.  The future and the life-events of a person
depend on what time he was born. But, the irony is that it is not under the
control of the person as to at what time he wants to be born. But the other
things that he performs in his lifetime are under his control. He can choose the
time of his performing any work. And that is what Muhurta is. If the begin-
ning time of the work is auspicious, then the result of the action will be very
fruitful and as desired.

Remember:  �Well begun is half done.�
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Calculations done for casting a Muhurta

Shri Muhurta has taken into account a huge number of factors which are
checked to find a Muhurta. Some of them are:

- Month

- Tithi

- Vaar

- Nakshatra

- Yoga

- Karana

- Tarabala

- Chandrabala

- Lagna

- AshtakaVarga

- Tithi-Day-Nakshatra combination yogas like Sarvaarth Sidhhi Yogas

- Strength and auspiciousness of Lagna

- Strength and auspiciousness of Lagna Lord

- Strength and auspiciousness of Significator houses

- Strength and auspiciousness of Significator house lords

- Strength and auspiciousness of Significator planets

- The 21 blemishes (Maha � doshas)

- The neutralization of the blemishes

- Special blemish removal yogas

- Special planetary positions and combinations as specified to be auspicious and in-
auspicious for the  important Muhurtas like Marriage, Journeys etc.
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Special Marriage Considerations

· Latta Dosha

· Patta Dosha

· Yuti

· Vedha

· Jaimitra

· Pancha Shalaka

· Ekargala

· Upagraha

· Kranti Samya

· Dagdha Tithi

- Various other astronomical phenomena for Muhurtas like Journeys in a particular
direction.

Special Journey Considerations

·     Tara

· Chandrabad

· Vaar Shoola

· Chandra Nivasa

· Yogini Nivasa

· Sam Shukra

But in spite of all these considerations, it remains to some degree a matter of
personal opinion whether a particular Muhurta is considered auspicious or
not by a particular Astrologer. Shri Muhurta helps you to find the best time
and date by finding an optimum amongst those factors, but it cannot guaran-
tee that there is no better option to match a particular astrologer�s knowledge.
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Another point to realize is that the Muhurtas are designed to support the
general significance of the particular activity.  A particular individual may
have a different perspective on that event, and must take the responsibility of
judging whether that Muhurta really applies on his case. Especially the auspi-
ciousness of the unique configuration in the chart is very subjective. Shri
Muhurta makes a judgment by using standard rules for affliction and benefi-
cial support, but does not analyze the chart to match the intentions of the
activity. For example in a Muhurta done for marriage, the lord of the 1st house
may be in the 3rd. This is generally not a bad place, but someone may object to
the individualistic nature of the 3rd house, and prefer a house placement that is
more family oriented. If marriage is for the purpose of getting rich, the 2nd or
11th house may be highly preferred.

The software allows the user to easily compare alternative options, and select
the one that suits him best. It is in this process that the user ultimately chooses
his destiny.
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Now that you have Shri Muhurta installed, we shall walk you through the
basic functions that you will use most.

File Menu

Add New User

To create a new User, click on the File menu and select Add new User. The
Birth Data entry screen appears. This screen contains all the different fields of
information to be specified. This has been explained elaborately with instruc-
tions in the next chapter.

Add New Location

This option in the file menu allows you to add a new location and has been
discussed in the next chapter also.

Language

The Language Option in the File menu allows you to choose your preferred
language for use of the program.

Chapter 3 : Using Basic Functions
of Shri Muhurta
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Exit

The Exit Option allows you to close the program.

Configuring Shri Muhurta
There are a few settings that dramatically influence the way the charts are
calculated and displayed. Because you may have a strong preference one way
or the other, we will explain right away the most important settings.

Options Menu

Display Option

In the Display Option in the Options menu, you can choose between North
Indian and South Indian Charts, between Traditional and Western Muhurta
Name Style and between whether the Time Zone should be displayed or not.
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The North Indian style is a diamond shaped chart where the houses have a fixed
location, and the signs are represented as numbers in the houses. The First
house, (also referred to as Lagna or the Ascendant), is always found in the top
middle area of the Chart. From there on, in a counter clockwise direction, the
houses follow in order.

        The North Indian Style Chart      The South Indian Style Chart

The second, South Indian style is drawn using squares for each house. In this
kind of Chart, the signs have fixed positions. The second square from the left
in the top row is always Aries (Mesha), the one on the right of that is Taurus
(Vrisha) and the rest follows in a clockwise order. The Ascendant is indicated
either by a diagonal line or by the symbol �As�. From the square (house) where
the Ascendant is located, all the other houses follow in clockwise order. Often
there is no sign or house number indicated in the South Indian style chart.

Fonts Option
This option allows you to decide in which font you want to view the System,
Graha, Rashi, English, Print and English Print  Fonts and the respective  font
sizes of the same.
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Calculation Options

The Calculations Option in the Options menu allows you to choose whether
you want the Hindu filter to be used in calculating your muhurta or not. This
means specifying whether the typically Hindu considerations are to be or not
to be taken into account in your case.
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· Adhik Maas

· Kshaya Maas

· Adhik Tithi

· Kshaya Tithi

· Shraadh Paksha

· Holashtak

· Mal Maas

· Dev Shayan Period

· InAuspicious Tithis

· Lagna Nature (Char, Sthira & Dwi-Swabhav Lagnas)

· Navamsha Nature (Char, Sthira & Dwi-Swabhav Navamashas)

· Inauspicious placement of Sun & Moon from Birth Rashi

· Jupiter & Venus combustion (Asta Graha)

· Daghdha Nakshatra

· Shunya Tithis·

· Shunya Nakshatras

· Shunya Lagnas

· Dagdha Lagna

· Shunya Rashi

· Inauspicious Tithi, Nakshatra & Vaar Combinations

· Inauspicious Tithis

· Panchaka  Period

· Bhadra Period (Swarg Lok Bhadra, Paatal Lok Bhadra, Mrityu Lok Bhadra)

· Rahu Kaal

· Aboojh Marriage Muhurtas
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Help Menu

About Shri Muhurta

This gives the information about the current version and the developers of the
software.

Help Topics
This leads you to the Online Help.
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The first time you run the program , you will see a screen like this:

For the election of any Muhurta, there are some basic requirements. The
Muhurta is always elected for a particular person and for a particular location.
Then it is to be elected within some specific time limit like a week, a month or
a year etc. All these have to be selected before the process of electing the
Muhurta can start. These selections have to be made within the screen.

Chapter 4 : Creating a Muhurta
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For example, we want to find a Muhurta for a man named Radhe Shyam,
born in LA, CA on June 4th, 1974. The Muhurta is for purchasing a vehicle,  say
a car, between July 1st, 1999 to Sep 1st, 1999 in Beverly Hills.

1. Birth Data Entry
You have to enter the birth information of the person for whom the Muhurta
is to be found. For this, you click on the Add New User button in the File
menu.

Then, you will see a window like this.
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By default, the cursor will be blinking in the Name field, and the program is
ready for you to type in the name. To move to the next field press TAB or click
on the next field with the mouse, whatever is easier for you. If you press TAB
to move to the next field, you will see that whatever text there is will be
highlighted. If you press any character key this character will replace the en-
tire area that is highlighted. If you do not want to replace it but just edit it,
touch any of the arrow keys and the text will go back to normal. To walk
through the different fields press TAB to go forward and SHIFT-TAB to go
backward.

Gender:
Click in the box that contains the right gender and proceed with TAB. It is
also possible to go forth and back between Male and Female with the Left and
right arrow keys.

Date:
The date can be entered in the format of  MM DD YYYY and spaced with a /
or a . For example: Jun/ 04 /1976 or Jun.04.1976 . Whichever format you use,
once you move to the next field (time), the date field will automatically re-
fresh and be formatted in the standard format.

Time:
It must be entered in the HH:MM:SS format. You can separate digits by any
non-character symbol.

Country:
The country is selected from a pull down list.

State:
The state is selected from a pull down list. The state field will only appear for
countries where the state information in available in the atlas. In case of USA,
if you enter the state abbreviation yourself, use the standard two letter abbre-
viations, in capitals. For example, for California use CA.

City :
Simply enter the name of the city.



19

Atlas lookup

Now you have entered the basic birth information, the program requires the
longitude, latitude, time zone and daylight savings/war-time correction. This
additional information is supplied with the program in the form of an atlas.
As the focus loses from the city field, the atlas lookup is automatically called.

If the city and state you specified are correct and unambiguous, then the time
zone, daylight saving, longitude and latitude will be looked up automatically.

The following things can happen at this time:

- The state is specified incorrectly: If the state is not recognized, you will get a
message �Incorrect State or Country�. You will have to enter a correct state
name first.

- The city is not found in the atlas exactly as you spelled it. You will get a menu
showing the cities with most similar names. From that list you can simply
select the city you want.
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- The city is found in the atlas, but there are several cities with the same spelling.
Also in this case, you will get a list from which you have to select the
correct one.

After this you are required to save this birth data to a file. All the charts will be
saved in the UrCharts folder. After you save the birth data of the person, it
will automatically appear in the list.

The next time when you want to find a Muhurta for a person for whom you
have already found a Muhurta and saved his data, you can select that person
from the list. You don�t have to feed in his birth data again.
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2. Entering the Muhurta Location

This is the place at which the Muhurta action is to be performed. For every
location, the Muhurta date and time will be different. For instance, if you
want to purchase a piece of land in Hawaii, then you have to select Location
as Hawaii. Or, if you want to marry in Los Angeles, then you have to select
the location as Los Angeles.

Then, you would see a window like this:

You can save the location for future use through this window which pops up
as soon as you click on OK. Click Save to store it permanently in the list.
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The next time, if you want to find the Muhurta at the same location, you can
just select it from the list.

3.  Selecting the Muhurta
 You can select the action for which you want to cast a Muhurta from the list.
For selecting any action, just click on it once. If what you want to do is not in
the visible portion of the list, you can scroll up or down. For instance, if you
want a Muhurta for Marriage, then just scroll down to the Marriage, part
through the scroll bar on the right of the window, and then click on Marriage-
Arranged Marriage. The list is sorted in the alphabetical order. The different
categories in which Muhurtas have been grouped are given underneath in an
alphabetical order.
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Baby
Business
Construction
Dealing
Education
Farming
Griha Pravesh (Entering a house for the first time)
Journeys
Manufacturing
Marriage
Medical
Misc.
Official
Pregnancy
Purchasing
Selling
Starting
Using
Wearing

4.  Begin Date
This is the date since when a
Muhurta is required. This, together
with the End date specifies the range
of dates within which a Muhurta is
required. For instance, if you want a
Muhurta between July 1, 1999 to Sep
1, 1999, then you have to select July
1, 1999 in the Begin Date. You can
select any year, month and date.
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5.  End Date
This is the ending date till when a
Muhurta is required. This, together
with the Begin date specifies the
range of dates within which a
Muhurta is required. For instance, if
you want a Muhurta from  July 1,
1999 to Sep 1, 1999, then you have
to select Sep 1, 1999 in the End Date.

6.  Date/Time Restrictions
If you want to exclude any particular weekday or any particular hours in find-
ing a Muhurta, then you can do so here. Generally, for selecting the best
Muhurta, all the dates and all the times within those dates are checked for
their auspiciousness. But you can apply some restrictions if you are sure that
you don�t want to perform a work on some specific weekday. In our case, we
will assume that we can buy a car on all days of the week. Also, we would
choose to buy it between 11 am and 6 p.m.

There are two types of restrictions.

a) Days Restrictions : Exclude days

b) Time Restrictions : Not before / Not After

Exclude Days

When any particular weekday has to be avoided in selection of the Muhurta,
it can be done by clicking in the square check box that is displayed just before
the name of the weekday in the Selection Screen. For instance, in the present
case, we will not check any of the  boxes from Sunday to Saturday.
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Not Before / Not After

When the Muhurta action to be performed has to be after certain hours then it
can be chosen by clicking on the down arrow button to the right of Not Be-
fore. For example, the work has to be performed after 11:00 a.m.. Then Click
next to Not Before. A list will be displayed with hours ranging from None to
23:00 hrs.  Then click on 11:00. Now all the time ranges before 11:00 a.m. will
be excluded.

In the same way, when the work has to be performed before certain hours, say
6 p.m., then select the hours, 6pm (18:00) hours in this case, from the list next
to Not After.

Select  None if you have selected some hours, and now you want to de-select
your choice.

Usually, when you want a perfect Muhurta, then its better not to apply any
restrictions. But then, it takes a lot of time. So, when you are sure that you
don�t want to fly on Friday or you wont be able to file an official application at
2:00 am in the morning, then its better to exclude these, which will help the
program to find the Muhurta quicker for you.
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7.  Start Muhurta search
After you are done with all the selections, click on the button Find Muhurta to
start the procedure of finding the best Muhurta.  There are three  buttons on
this screen  that have not been explained yet:

Refresh

It sets all the settings to default (as they were originally) once again. For in-
stance, if you have selected the begin date to be one month from the current
date, and then you click on refresh, the begin date will be set to the current
date that is the default date.

Help

This button leads you to the Online Manual.

Exit

This button will lead you out of the program.

8.  After Searching the Muhurta
You will now see a window that shows the dates and times being processed
on. After that, the best date will be processed on to calculate detailed auspi-
ciousness report on a minute by minute basis. At this time, you will see what
percentage of the work has been completed and how much longer will take.
Once  this process is complete, you will see the Muhurtas that the software
has selected for  you.
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In case there is no auspicious muhurta during the period specified by you, a
window will appear advising you of this and asking you to increase the span
or change the limits of the restrictions provided by you.
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The computer evaluates all the dates and times between begin date and end
date for their auspiciousness. It checks for all the of Panchanga elements rel-
evant for the Muhurta action like Tithi, Karana,  the blemishes and their neu-
tralization, the AshtakaVarga of the relevant planets and houses, the combi-
nation Yogas formed on the basis of combination of some Tithis, Nakshatras
and weekdays, the planetary positions and combinations in the Muhurta chart
and numerous number of other factors. After all the dates and their times are
evaluated, the best dates are sorted based on the level of their auspiciousness
and displayed in the Dates List. By default, the best date is selected and its
best times are displayed in the Times List in a sorted basis. By default, the best
time range is selected and its Panchanga data and the auspicious and inauspi-
cious combinations are displayed underneath and its Muhurta chart and the
Muhurta navamsha is displayed on the right.
So, in our case, this is what you will see.

Chapter 5 : Viewing the Muhurta
Search Results
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Dates List
This is the list of Muhurtas, i.e. this is the list of the best dates on which the
desired action should be performed. It contains the dates, their maximum aus-
piciousness and their minimum auspiciousness. Maximum auspiciousness is
the highest auspiciousness of the day at some time within the day. Usually, all
the times of the day don�t carry the same amount of auspiciousness. Some
times are more auspicious than the others. Minimum auspiciousness means
this is the least amount of auspiciousness that existed during the day at some
point of time. Usually, we are not concerned with it. The list is sorted on
maximum auspiciousness. The topmost date is the most auspicious and the
auspiciousness goes on reducing as you go down the list. In our case, Septem-
ber 1st. is the topmost date. So, it is the most auspicious Muhurta, i.e. Radhe
Shyam should go for buying his car on the 1st of September, 1999. Its maxi-
mum auspiciousness is 360 points.

Times  List
These are the times of the selected date. The time is given as a range (the
starting time and the ending time). Like, 11.00 to 13.00 or 13.11 to 14.01 in
this case. It means that the auspicious-
ness remains the same within that time
range. Also, the same planetary condi-
tions and Panchanga data exist in a single
time range. To the right is the auspicious-
ness of that time range. The Muhurta is
not a particular point of time but a span
of time within which you can perform
the work. The level of auspiciousness is
displayed right at front of the time range.
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In this list that you see, the first Muhurta is from 11.00 to 13.00. Its auspi-
ciousness is 200 points. Then, the second range is from 13.11 to 14.01. Its
auspiciousness is also 200 points. But, even though these two ranges are hav-
ing 200 points, they are grouped differently because some or the other astro-
nomical or astrological phenomena differ between these two. Generally, you
can perform your work in any of these time ranges after checking out for their
auspiciousness. Now, here we can see that the first range is 2 hours and the
second one is 50 minutes. So, for purchasing a car, Radhe Shyam would gener-
ally prefer the first range as both of them are carrying 200 points. If you want
to see the planetary details of the second time range (13.11 to 14.01), then you
can click on that and the relevant details would be updated for this time range.

Selected Date

This is the Muhurta, i.e. when you see this screen for the first time, then
whatever date is the selected date is the Muhurta date. In this case, Sep 1,1999,
which is at the top of the list is the selected date. This list is sorted on Maxi-
mum auspiciousness. So, the date displayed at the top is the most auspicious.
So, by default, in the beginning, the most auspicious date at the top is se-
lected. So, Sep 1, 1999 is the Muhurta date in this case. That means that Sep
1,1999 is the most auspicious date when the work should be performed. The
second most auspicious is Aug 24 and so on. The time ranges, Muhurta chart,
Muhurta navamsha, Panchang details, graph etc. that you see, all belong to
the selected date. So, if you want to see the time ranges of a different date in
the date list, then you can select any date just by single-clicking on it. It will
then calculate the auspiciousness of that date on a minute to minute basis and
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in a few minutes will show you the time ranges, Muhurta chart and navamsha,
and the Panchang details of that date and the selected time range within that
date.

Selected Time

The time range that is having a blue background is the selected time. The
Muhurta Chart that is displayed is of the selected date and the selected time.
The Muhurta navamsha that is displayed is not always the same for the time
range. Only the Lagna is the same for a particular time range. The Muhurta
Navamsha is the same for a particular time range only when it is significant in
the Muhurta. The time range basically means that the Panchanga data that is
displayed belongs to this time range. And the Muhurta Chart that is on the
right side also belongs to this time range. That is, it did not change within this
time frame. When you take a printout, all the Panchanga data and the auspi-
cious and inauspicious combinations that exist for this time range will be
printed. That is, the printout belongs to this selected date and selected time
range.

Muhurta Chart
The Muhurta chart is the representation of the planetary positions present at
the time of Muhurta (the given date and time) in a specific format. It has 12
houses, 12 different rashis (signs from Aries to Pisces), and 9 grahas (Sun to
Ketu). Each house contains a rashi. Each planet is placed in any one of the 12
houses and is auspicious or inauspicious according to its house position and
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rashi present in that house and thousands of other factors and combinations.
All the houses, rashis and planets have different categories. Each house repre-
sents different areas of life. There are hundreds of further subdivisions in the
chart. The total number of different factors and possibilities is somewhere
near the total number of atoms in the whole Universe.

Muhurta Navamsha

The Muhurta Navamsha is the Navamsha calculated for the Muhurta chart.
(The Navamsha is one of the 15 divisional charts).
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Panchanga data

This contains the Panchanga data that exists on the selected date and the
selected time. It contains the tithi, day, nakshatra, karana, yoga, combination
yogas, ashtakavarga totals, planetary positions and combinations existing on
that date and time range in the Muhurta chart and Muhurta navamsha, blem-
ishes if existing, blemish removal yogas, the strength and auspiciousness of
the significator houses, significator planets, the lagna and the lagna lord etc.

In the present case, the Month is Sravana and it is neutral to the Muhurta, i.e.
its neither auspicious for the Muhurta  nor inauspicious. Tarabala  which is
Kshema is auspicious. Lagna  which is Libra is inauspicious. Then, there are
excellent Yogas like Sidhhi Yoga and Sarvarth Sidhhi Yoga forming which are
very auspicious.  It is very interesting to note that no Muhurta is completely
auspicious or completely inauspicious. There are always some elements that
are auspicious and some inauspicious. What is really important in finding a
Muhurta is that how many elements are auspicious, and what weightage is
attached to them. It is also to be kept in mind that the major inauspicious
elements are to be avoided. All this is taken care of by the program. So, don�t
worry when you see a red spot out there. You can be sure that the software
knows this, and is still recommending this Muhurta because it is much better
than the other ones.
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Pick List

The PickList facilitates the comparison of  2 or more charts. The chart which
has to be compared has to be added to the PickList by clicking on Add To
PickList. After the charts are selected in the PickList, �charts button� can be
clicked to see all the selected Muhurta Charts at a time in a different screen.

Add To PickList

It adds the Muhurta chart of the selected date and time range in the PickList.
At a maximum, you can add 8 Muhurta charts in the list. That implies that at
a time you can compare maximum 8 charts.
To add any time range to the PickList, just select it by clicking on it and then
click on Add To  PickList. To select more than one, just repeat the process with
a different time range.

Remove Button
Clicking on this button removes the current selection from the PickList. The
removed date and time is then no longer available for comparison. This is
useful when either you have added any time range in the PickList by mistake,
or wanted to compare it earlier and now have changed your mind, or have
already compared it and now want to make new selections.

Tip: You can remove an item from the PickList even by double-clicking on it.
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Back button
Clicking on Back takes the control to one screen back. It takes the control to
the last screen from which the current screen was opened. So, when you click
on Back from the Results Screen, then you go back to the first screen, the
Selection Screen.

Charts Button

It opens another screen with all the horoscopes selected in the PickList. This
facilitates comparison of the all the horoscopes at a time.

Graphs Button

It takes you to another screen, Graphs screen, where you can view the auspi-
ciousness of the different time ranges of the selected date graphically.

Advanced results screens

Graphs Screen

This screen shows the graphical representation of all the times of the selected
date. The x-axis represents the hours and the y-axis represents the auspicious-
ness. The longer the green bar, the more auspicious the Muhurta is. As we
have seen earlier, the Panchanga elements (Tithi, Nakshatra etc.) change dur-
ing the day. All these Panchanga elements that change during the day within
the time periods that you have specified, are shown in the form of colorful
lines. The lines are shown corresponding to the times changing. The Panchanga
elements changing times are shown below in the form of tables. The Lagna is
represented in red, the Nakshatra in deep blue and so on. For instance, in our
case, the Lagna Libra (the seventh Lagna) depicted as a Red line ends some-
where after 13 hours. The eighth Lagna starts there. And, in the bottom left
corner of the screen, you can see that the ending time of the Lagnas are given.
So, we can see that Lagna Libra ends at 13.01 hours and so on. In the same
way, the 2nd Nakshatra is shown in blue line as ending in the middle of 8 to 9
hours. And, at the bottom of the screen under the heading Panchanga (ending
time), we can see that the 2nd Nakshatra�s name is Bharani and it ends at 8.25
hours. While displaying these Panchanga elements, only those ones are acturatly
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taken, which lie within the time frame that you had selected in the beginning,
like in our case, between 11:00 hours to 18:00 hours in our case. The sunrise
and sunset are also represented graphically in the form of colorful lines.

Usually, in addition to looking for the tallest green bar, it is also advisable to
look for the width of the bar (the wider the bar is, the longer the duration of
the Muhurta is)  when the Muhurta action you want to perform has a lot of
interrelated activities and all the activities can not be performed in a very
short span of time. For instance,  if a time range of 5 minutes is having 90
points of auspiciousness, and another time range of 60 minutes has auspi-
ciousness as 80 points, then you might like to choose the later if say you are
going for purchasing a car, as it is a sequence of related activities and no par-
ticular activity in isolation can be termed as purchasing a car. On the other
hand, if you have cast a Muhurta for  wearing a necklace, then you might go
in for the former one, because putting on a necklace does not take long.
If you want to figure out why is a particular time range having more points
than the other, than you might go back on the results screen and click on that
particular time range in the Times List and then look for the Panchanga data
and the Muhurta chart.
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Abbrevations
a. T : Tithi. For eg, TS09 is 9th Tithi of Shukla Paksha (bright half).

   TK08 is 8th Tithi of Krishna Paksha (dark half).
b. N :  Nakshatra. For eg. N09 is the 9th Nakshatra.
c. Y :  Yoga.
d. K :  Karana.

Print button
It prints the graph on paper.

Back button
It takes you back to the Results screen.

Help button
Click on Help to see online help.

Charts/Comparison Screen
This screen displays all the charts, that have been selected in the PickList. The
Date and Time for which the chart is shown is also displayed above the charts.
This facilitates the comparison of the auspiciousness of the Muhurta charts of
different dates and times by a knowledgeable person.
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You can take a printout of the selected Muhurta. The printout is of two types.

a) Muhurta chart and astronomical Details.

b) Auspiciousness details of the Muhurta

You can take both these printouts by clicking on the �print� button in the
Results Screen.

The printouts that you will get will be for the selected date and time, i.e. the
Muhurta chart, the astronomical phenomena, the auspiciousness details etc.
will belong to the currently selected date and time.

Chapter  6 : Printing a Muhurta
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Auspiciousness Graph

You can print the auspiciousness graph by clicking on the �button� on the Graphs
screen. The graph will be for the selected date. The selected time doesn�t mat-
ter in the graph printout because all the auspicious times will be shown in the
graph regardless of which one is selected.
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1) Enter the Birth Data of the person for whom the Muhurta is to be
selected. On Screen 1 click on  �Add New User� in the File Menu .
Alternatively, if you have already found a Muhurta for that person
before, and entered in his/her data, and saved it, then you don�t need
to feed in the birth data of that person again. You can select it from
the list of the persons. The birth data of that person will be taken
automatically.

2) Choose the location where the event is to take place. Click on �Add new
Location� in the File Menu to do that or select from the list.

3) Select the event/activity for which Muhurta is to be selected. The list
is given on the left side of Screen1.

4) Choose the Begin Date.

5) Choose the End Date.

6) If you want to avoid some specific weekdays, then check the boxes
next to the weekdays at the bottom of the screen. The checked week-
days would not be considered for calculating the Muhurta.

7) If you want the Muhurta to be cast only after given hours and only
before given hours, then you can select so from the list boxes at the
bottom of the screen. For instance, if you are sure that you don�t want
to marry before, say, 8:00 o�clock in the morning, then you can select 8

Appendix 1: Step by step guide
to find the best Muhurta
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in the �Not earlier Than� list. Similarly, if you are sure that you won�t
get your child admitted in school after 18:00 o�clock, then you can se-
lect 18 in the �Not Later Than� list.

8) If some wrong data has been entered or selected, any of the above pro-
cesses can be repeated. If you want all of the options to be set to de-
fault, click �Refresh Button�.

9) Click on �Find Muhurta Button�  to proceed to the next screen. The best
dates and times will be calculated as the dates and times on which the
processing is going on will be shown on the screen for a while. The
next screen will be shown when the processing is complete. The approx.
time taken will be somewhere between 5 minutes  to 20 minutes de-
pending on the difference in the no. of days between the Begin date
and the End date that has been selected. The lesser the difference be-
tween the End date and Begin date, the lesser time its going to take.
And the more the day and time restrictions applied, the lesser time it is
going to take.

10) Results screen appears now. There is a �Dates List� in which the most
auspicious dates are given sorted according to their auspiciousness. The
date which is at the top is the most auspicious date to perform the
work. That is, it is the most auspicious Muhurta date.

11) The �Times List� contains the times for that particular date which is
selected in the date list. Initially, when you see this screen for the first
time, the best date which is at the top will be selected by default. So, all
the times that you see in the Time List are of the best date. The times
will also be sorted on maximum auspiciousness. The times are in ranges.
For instance, from 8:10 hours to 9:50 hours. This means that the auspi-
ciousness for that time range is the same, and the planetary and
Panchanga details for the given time range are the same. Only the
Muhurta Navamsha and the planetary degrees may vary, if they are
not of relevant significance. Initially, the best time of the best date will
be selected by default.
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12) The Muhurta Chart that is shown is for the particular date and par-
ticular time range which is currently selected.

13) The Muhurta navamsha shown is for the beginning of the Time Range
selected. It doesn�t remain the same for the total time range. It remains
the same for the time range only when it is significant in choosing of
the Muhurta. This is because, when the Muhurta Navamsha has a sig-
nificant role in the auspiciousness of some of the Muhurtas, then it
will lead to a change in the auspiciousness in between the time range,
which is not possible because one single time range is supposed to have
the same auspiciousness. Similarly, when it doesn�t effect the auspi-
ciousness at all, then there would be no effect on the auspiciousness
within a time range which contain many Muhurta_Navamshas. When
the Muhurta Navamsha is insignificant for the Muhurta, it is no use
separating the time ranges over every 5 to 15 minutes(Muhurta
Navamsha).

14) Panchanga data contains the data for the selected date and selected
time. A green ellipse denotes that this particular element is auspicious
for the work to be performed. Yellow denotes that its neutral. And Red
means inauspicious. The second list is scrollable.

15) Click on print if you want to take a printout. The printout contains all
the Panchanga details, with the Muhurta Chart and the Muhurta
Navamsha, the Birth Chart of the native, the auspicious and inauspi-
cious combinations present. The printout will contain the details for
the selected date and the selected time range.

16) For comparing the Muhurta charts of different dates and times your-
self, you can click on �Add to PickList� to add the currently selected date
and time to the PickList.

17) Click on Graphs to see a graphical representation of the auspiciousness
of that date. The graph will also show you the changes in the Panchanga
elements like Tithi etc. if they took place within the time restrictions
that you had applied in the 1st Entry screen. It also shows you the tran-
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sit of the planets if any and the local sunrise and sunset of the Location
that you want a Muhurta for.

18) Click on �Charts Button� to see multiple charts at a time for compari-
son.

19) You can see the Panchanga details and Muhurta Chart and Muhurta
Navamsha  of any of the time ranges by clicking on it in the time list.

20) Similarly, if you want to see the best time ranges and other details of
the other dates in the list, then click on any of the dates in the dates
list. The new calculations will take around 5 minutes and then the new
time ranges would be shown.

21) Click on �Back button� to return to Screen1.

22) For choosing another Muhurta repeat the same process  from point
no. 1.

23) Click on �Close Button� for shutting down the application.
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The Shodash Samskaras

1. Garbhadhan Samskara : Conception.
2. Punsavana Samskara : To get male child; to protect preg-

nancy and to avoid abortions.
3. Seemanta Samskara : To protect pregnant woman from

evil forces.
4. Jaat Karma Samskara : Father blesses the child.
5. Naamakarana Samskara : Naming the child.
6. Nishkramana Samskara : The child goes out of the house for

the first time.
7. Annaprasana Samskara : First time feeding of solid food to

child.
8. Karna Vedha Samskara : Ear piercing
9. Chudakarana Samskara : Tonsure
10. Akshararambha Samskara : Introducting the child with alpha-

bets
11. Upanayana / Yagyopavita : Wearing of sacred thread
12. Vedarambha Samskara : Learning of Vedas
13. Keshanta Samskara : First shaving
14. Samavartana Samskara : Home coming after completing

education
15. Vivaha Samskara : Marriage
16. Daha Samskara : Funeral Rites

Muhurtas specially for females

Prathma Rajodarshana Muhurta : First apperance of menstrual excretion
Taking bath after menstrual period

Appendix 2: List of supported
Muhurtas
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Pregnancy

First pregnancy/conception after marriage
Garbhadhan : Conception
Punsavana : Rituals to change child�s sex
Ceremony performed on the third month
Ghati Dharan Muhurta
Pregnancy diet of a woman
Lying in Apartment
Treatment of pregnant woman
Seemantha
Worship of Vishnu

Baby

Jaat-Karma Samskara : Birth ceremony of a child
Stanapana Muhurta : Breast feeding for the first time
Prasoota Snana : Taking bath after delivery
Namakarna Samskara : Naming the child
Dola-arohana : Cradling
Jala Poojan : Worship of river, well, ponds, etc. after delivery
Feeding cow milk after 31 days of birth
Giving betal leaf after 2-1/2 months of birth
Niskramana Samskara : Going out of house for the first time
Sitting on land for the first time
Feeding rice for the first time
Ear Boring (Karnavedha)
Tonsure (Chowlam)

Education / Learning of

To Learn Alphabet / Learning how to write
Admission to School / Commencing Education
Investiture with sacred thread (Upanayanam)
Learning of Astrology and Astronomy
Learning of Dance and Music
Learning of Grammer, Logic and Philosophy
Learning of Trade, Business, Commerce
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Learning of Science
Learning of Medicine
Learning of Vedas and Shastras
Convocation (Completing studies)

Marriage

Vara-varana Muhurta : Selecting Bridegroom
Kanya-varana Muhurta : Selecting Bride
Mutual acceptance of Marriage
Sagai Muhurta : Engagement Ceremony
Swayambar (Choosing of Groom by Bride)
Love Marriage
Oil Anointing/Smearing
Construction of Vedica (altar) / Platform
Sitting on Marriage Pavillion
Marriage Ceremony (Vivaha Samskara)
Vadhu-pravesha Muhurta: First time entering husband�s house by bride
Dwiragamana Muhurta : Second time entering the husband�s house by bride
First time cooking by the Bride
Re-Marriage

Grih Pravesh

Entering into a New House
Entrance in Broken/Repaired/Old house
Worship of Vastu Lord

Making of

Bed, Swing, Quilt etc.
Clothes
Ornaments without using jewels
Clothes with Embroidery Work

Using things

New Bed, Swing, Quilt etc. (1st time)
Items like Camphor, Sandal etc.



47

New Account Book
New Utensils
Oil for massage

Wearing

Bangles
New Ornaments
Red Clothes (first time)
White Clothes (first time)
Yellow clothes (first time)
New clothes by a man
New clothes by a woman
New hat, crown, turban, etc.
Woolen clothes
Clothes woven with golden or silver thread
Armour
Weapons

Journeys

Short Journeys
Long distance Journeys
Journey by Sea
Journeys by Air
Journeys for business
Pilgrimage

Medical

Begining medical treatment
Dental treatment
Nose treatment
Surgical Operations
Taking enemas
Taking injections
To Prepare medicines
Treatment for cunsumption
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Treatment for epilepsy
Treatment for leprosy
Treatment of Veneral disease

Starting

Dairy Farms
Poultry Farming
Fish Farming
Jewelry Work
Leather Work and wearing new leather shoes
Machinery
Opening a Shop
Putting new ship/boat into water

Business

Buying and Selling of cows/cattle
Buying and Selling of elephants
Buying and Selling of Goats, Cows etc.
Buying and Selling of Horses
Establishing Large-scale Business
Establishing Small-scale Business
Gold and Gold Ornaments
Precious Stones (cutting and polishing)
Selling for making profit
Vehicles
Selling of Things

Dealing in / Trading

Borrowing Money
Depositing the money
Depositing the Money in the Bank
Lending Money
Loan Giving
Loan receiving
Loan repayment
Recovering Due Money
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Purchasing

Arms
Buying Cattle
Buying House
Buying Sheep
Items for Business
Jewelry
Jewels
Land
Land for building
New items
Utensils, etc.
Vehicles

Official

Appointment on a new post/Career
Joining Government Service
Coronation
Democratric rule
Electing Head of the State
Filing Application
Filing Law Suit/Court Case
Meeting with High Officials
To apply for a job or Party tickets, etc.
To meet the Higher Authorities

Construction

Boring, Swimming Pool, Lake, Well, Pond etc.
Building Ships
Collecting Material like bricks etc.
Cutting Wood, Marble, etc.
Dismantling buildings
Establishing colonies, villages etc.
Fixing Door/Door Frame
Foundation of Boring, Well etc.
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Interior Decoration
Laying Foundation
Laying Pillars
Making a new house
Making Jain Temples, Monastery, Church
Making new bridges
Making New Temples
Parliament, Royal/Govt Houses, Forts
Repairs and maintenance of house
Small water tank
Tank for Aquatic Plants
Tying Flowers (Vandan Mala) around house
Village Assembly
Water Tank etc. at Home

Farming
Adding Fertilizers/Manure
Buying Land
Collecting and Storing Cereals
Crushing/Grinding Cereals
Cutting Off Cereals
Felling Trees
General
Grafting and Pruning
Harvesting
Lending Cereals to Fellow Farmers
Planting
Ploughing the Field
Putting Plough on the oxen
Selling Cereals
Sowing Seeds in the Field
Watering

Miscellaneous
Appeasing the Planets
Doing a Havan / Oblation
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Havan/Oblation for satisfaction of a deity
Initiation in a Mantra
Installing a Deity
Investiture of Sacred Thread to get Relief
Cutting Nails
Shaving
Make-up
Washing of clothes/Giving in Laundry
Coloring of clothes
Eating nine types of cereals for first time
Dinner of New Grains
Tasting of water drawn from a new resource
Destroying strongholds
Division of Property
Employing New Servants
Final Liberation for Investiture of Sacred Thread
First time Riding of an automobile or a Horse, etc.
Playing Musical Instruments for the first time
Forming a Library
Horse Races
Lotteries and Competitions
Inauguration of School, Hostel, Boring, Garden.
Keeping/Taming/Fostering  Birds
Pet Animals like Dog, Cat, Parrots etc.
Pledging
Making a Will
Making weapons containing a hole (eg. Guns)
Moving to another House
Shifting from place to place
Plantation of trees and plants
Taking First Bath after Illness
Time for expanding a sovereign
Writers beginning writing
Adopting a Child
Seeking Escaped Prisoners
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Starting Wars
Starting Black Magic
Physical Exercises (first time)

Cremation
Funeral Rites: when dead body is available
Funeral Rites: when dead body is not available
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Why does the search take so much of time

Your software calculates the Muhurta for you after considering all these fac-
tors and many more. Now let us figure out how many calculations are done
for a Marriage Muhurta in the next three months.
First of all, each day will be checked on almost each lagna. Each day is checked
about 13 times a day. So, for 3 months, the software has to check it for 13 * 90
= 1170 times approx. Then for the best day, it checks for each minute, i.e.,
1440 times. So, 1170 + 1440 = 2610 times. Therefore, for a Muhurta of three
months, the Muhurta chart and Navamsha will be drawn for 2610 times. For
each time, the software checks about 100 conditions for its auspiciousness.
So, the total calculations will be about 2610 * 100 = 261,000. The auspicious-
ness of all these times will be stored in the computer and will be sorted and
analyzed on different other considerations before coming out with a Muhurta
for you. And, when you click on another date to find the best time ranges of
any other date, then 1440 * 100 = 144,000 calculations will be done again. So,
though it takes some time, it does not waste it. It is doing hundreds and thou-
sands of calculations in order to find the best Muhurta for you.

What you can do to speed it up

When you make the specifications for finding a Muhurta, give the minimum
date and time range within which you want to perform the work. For in-
stance, if you want a Muhurta for filing an official application, then its wise
enough to give the time range within the official hours, and not a 24 hour
time range. In the same way, you can exclude the days on which you don�t
want to perform the work for sure.

Appendix 3: Tips and tricks
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Miscellaneous

Clicking on the gray dates of the previous/next month changes the month
automatically to the previous/next month and the date that is clicked is auto-
matically selected. For instance, if you are presently on July 4, 1999 and you
want to go on June 1, 1999 and if you see 1 in grey before the dates for July
start in blue, then if you click on 1, then June 1, 1999 will automatically be
selected.  Same is the case when jumping to the next month.
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Glossary

Tithi :
Tithi is calculated on the basis of Lunar transits. It depends on the distance
between the Sun and the Moon. When the distance between the sun and the
moon is between 0 degree to 12 degrees, Tithi is said to be Prathami or first,
and from 12 to 24, its Dwitiya or second and so on.

There are categorized in 2 categories. Shukla Tithi (the bright half) and Krishna
Tithi (the dark half). When the moon is waxing, it is known as Shukla Paksha
(half) and when its waning, its known as Krishna Paksha (half). So, when the
distance between the sun and the moon is say 6 degrees and the moon is wax-
ing, then it will be known as Shukla Prathami, i.e. first tithi of the bright half
and so on.

Day :
The weekday like Sunday, Monday� according to the Hindu Calendar. Hindu
day starts at sunrise in the morning and ends at the sunrise of the next morn-
ing. For instance, at Monday, 2:00 hours, its Sunday according to the Hindu
calendar, and at Monday, 8:00 hours, its Monday according to the Hindu cal-
endar. That is, before sunrise, it�s the previous weekday, and at and after sun-
rise, it�s the same weekday according to the English calendar.

Nakshatra :
The sky is divided in 27 constellations for the astrological purposes. Each con-
stellation is known as a Nakshatra. The  Nakshatra specified in the Panchanga
data is the Nakshatra in which moon was present at that time.
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Karana :
Each tithi is divided in two parts. Each of the two parts is known as a Karana.
There are 11 Karanas in all. But, they are used repeatedly to make it work for
all the 30 Tithis.

Yoga :
There are 27 Soli-Lunar yogas. They reflect the nature and effect of interac-
tions of Sun and Moon. These are calculated by adding the degree positions.

Combination Yogas :
There are special yogas formed by the combination of particular tithi, day,
nakshatra etc. Even if the tithi is inauspicious and the Day is inauspicious, and
the Combination Yoga formed is auspicious, then it overrules the inauspicious
effect of tithi and day and the day and time becomes auspicious. So, we can
say that, the combination yogas are more powerful and effective than indi-
vidual elements like Tithi etc. They supercede the individual elements� auspi-
ciousness/inauspiciousness. A good combination Yoga like Sarvaarth Sidhhi
Yoga is said to remove hundreds of evil influences in the Muhurta Chart.

Ashtakavarga :
These are the Sarva Ashtaka Varga points given according to the Birth Chart
of the native. The points of the house which occupies the rashi that the planet
is falling in, in the Muhurta chart are taken for this purposes. This implies
that if two or more planets are in the same rashi in the Muhurta chart, they
would get the same number of AshtakaVarga points. For instance, if Mercury
is in Aries in the Muhurta Chart. And the house which has Aries in the Birth
Chart of the native is having 32 points. So, Mercury will be said to have 32
Sarva Ashtaka Varga points in the Muhurta Chart. Anything above 28 is strong
and below 25 is weak.

Blemishes :
There are certain flaws and  planetary positions which should be avoided in
the election of a Muhurta. They are known as blemishes.

There are 21 blemishes in all. Some of them are, Surya Sankranti ( the ingress
of Sun in a new sign), Moon in the 6th, 8th or 12th houses, Eclipse etc.
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Month :
This is the Month according to the Hindu calendar. A month consists of 30
Tithi. There are 12 Hindu months. When �Adhika� is added before the name of
the month, that means that there is no Solar Sankranti in that month. The
Hindu month is usually of a little less duration than the month according to
the English calendar. Therefore, in around every three years, there is one Adhika
Month.

Solar Sankranti :
When Sun changes its sign(Rashi), its known as a Solar Sankranti. That is,
when it leaves one sign and makes ingress in another sign, it is known as Solar
Sankranti.
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